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Management Central

Are you interested in making your system administration tasks simpler, easier, less time-consuming, and
much less repetitive? Are you looking to lower your overall total cost of server ownership? iSeries'™
Navigator provides the technology you need to do systems management tasks across one or more servers
simultaneously.

Click Management Central in iSeries Navigator to find easy-to-use systems management functions that
come to you as part of your base operating system. Management Central in iSeries Navigator allows you
to manage one or more systems through a single central system. Simply select a server to use as your
central system, then add endpoint systems to your Management Central network. You can create groups
of similar or related endpoint systems to make managing and monitoring your systems even easier. Your
central system will handle the communications for you. You can even take advantage of such options as
scheduling and unattended operations. You'll find that Management Central is flexible and easily
manipulated to suit your needs.

With iSeries Navigator for Wireless, administrators have even more flexibility in how they access and
interact with Management Central. See the [iSeries Navigator for Wireless overview| for tips on which
devices to use, how to install and configure the required elements, and a comprehensive overview of the
functions.

To make the most of Management Central’s flexibility and function, read about the overview of the
functions, and see what’s new:

[“What's new in Management Central for V5R3"]
Find out what’s new for the current release!

|“Print this topic” on page 2|
Download and print a PDF of this topic and other related topics.

|“Get started with Management Central” on page 3|
Start using Management Central! To get the most out of Management Central, set up your central system and
endpoint systems in a way that makes sense for your business environment.

|“Working with Management Central” on page 6|

Find out about all the ways Management Central can help you streamline your server administration tasks,
such as managing fixes, monitoring performance, and administering users and groups on one or more servers
in your network.

What’s new in Management Central for V5R3

The Management Central topic contains information specific to the systems management functions of
iSeries'™ Navigator — information you need to effectively manage multiple iSeries servers.

To find out what functions are available for each 0S/400® release, see the [Functions available by release]
topic.

Synchronize functions

You can now [synchronize key functions| such as EIM and Kerberos, across a group of endpoint systems.
You specify the model system and then use the new Synchronize Functions wizard to duplicate the
model system’s Kerberos or EIM configuration on the endpoint systems you specity.
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Synchronize date and time

Management Central now uses the new time zone (QTIMZON) system value when [synchronizing the]
[date and time valueg on target systems with a model system. This means that it is no longer necessary to
manually update the GMT offset (QUTCOFFSET) system value on the target systems when the source
system changes to or from Daylight Saving Time (DST).

Use Kerberos authentication

You can now choose either profile and password authentication or Kerberos authentication to
authenticate the Management Central server on the remote systems. When you select to use Kerberos
authentication, Management Central will use Kerberos authentication to authenticate the Management
Central server on any remote system that is running OS/400 V5R3 or later and has Kerberos configured.
When connecting to other systems, Management Central will use profile and password authentication. If
you select to use Kerberos authentication, you may also select to use Enterprise Identity Mapping (EIM)
to associate users.

You can use Kerberos and EIM together to implement a single signon solution that will simplify the task
of managing user profiles, while reducing the number of signons that a user must perform to access
multiple applications and servers. See Scenario: Configure the Management Central server] to learn how
to configure an entire system group to participate in a single signon environment. After administrators
complete the scenario for propagating a single signon configuration across multiple systems, they can do
the necessary configuration so that the entire system group can participate in the single signon
environment.

Of course, you must have SSL, Kerberos, and EIM all properly configured on a system before they can be
turned on for Management Central or any other application to use.

Automatically reset thresholds for monitors
Now you can select to have thresholds for file monitors and message monitors automatically reset when

your trigger command is run. When you [define a threshold| and specify a command to be run when the
threshold is triggered, you just select Automatically reset after trigger command has run.

How to see what’s new or changed

To help you see where technical changes have been made, this information uses:
* The ¥ image to mark where new or changed information begins.

e The # image to mark where new or changed information ends.

To find other information about what’s new or changed this release, see the

Print this topic

To view or download the PDF version of this document, select [Management Central| (about 250 KB)

These topics tell you how to set up your network of endpoint systems and system groups as well as
perform a variety of tasks. They also include information about all the ways iSeries'™ Navigator can
help you streamline your server administration tasks, such as:

* Manage users and groups

* Collect inventory and performance data
* Manage system values

* 3 Synchronize functions«<¥,

* Package and send objects
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* Run commands
* Schedule your tasks or jobs

You can view or download these related topics:

. (about 1100 KB) contains the following topics:

— Collection Services

— System monitors, job monitors, message monitors, B2B monitors, file monitors

* Boftware and licensed programsg| (about 350 KB) contains the following topics:

— Fixes
— Product packaging

— Licensing

Other information

You can also view or print any of the [‘Related information for Management Central” on page 8.|

Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF in your browser (right-click any of the PDF links above).

2. % Click Save Target As... if you are using Internet Explorer. Click Save Link As... if you are using
Netscape Communicator.<%,

3. Navigate to the directory in which you would like to save the PDF.
4. Click Save.

Downloading Adobe Acrobat Reader

# You need Adobe Acrobat Reader to view or print these PDFs. You can download a copy from the
|[Adobe Web site| (www.adobe.com /products/acrobat/readstep.html) -Id' .

Get started with Management Central

Start clicking Management Central in iSeries™ Navigator to manage all your systems! Follow a few
simple steps to set up your systems for Management Central:

1. [“Install and access Management Central” on page 4|
Some of the systems management functions that you will want to use are optionally installable
components of iSeries Navigator. Be sure you choose to install them when you [install iSeries
Navigator] Find and open Management Central in your iSeries Navigator window.
2. [“Set up your central system” on page 4|

You choose your central system when you first start iSeries Navigator. You can also change your
central system easily at any time.

3. [“Add endpoint systems to your Management Central network” on page 5
Endpoint systems are the systems in your network that you manage with your single central system.
Find out how to add the endpoint systems that you want to manage.

4. [“Create system groups in your Management Central network” on page 6|
Make the most of iSeries Navigator’s ability to manage groups of systems. If you are working with
multiple systems or multiple logical partitions, creating a system group allows you to perform tasks
on all the systems without selecting each endpoint system. Just select the system group you created
and start your task!
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When you have finished these preliminary steps, you're ready to start ["Working with Management
[Central” on page 6.|

Install and access Management Central

Some systems management functions are optionally installahle-components-otiSeries ™) Navigator] the
graphical user interface (GUI) for iSeries servers. When you finstall iSeries Access for Windows™)} be sure
to select iSeries Navigator in the Component Selection window. When you select iSeries Navigator, iSeries
Navigator Base Support is automatically selected. iSeries Navigator Base Support includes some of the
systems management functions. To get all of the systems management functions, be sure you also select
Configuration and Service, Users and Groups, Commands, Packages and Products, and Monitors.

If you did not install all the components you need when you installed iSeries Navigator, do the
following:

1. From the menu bar in iSeries Navigator, select File -> Install Options -> Selective Setup.
2. Use the Selective Setup wizard to install the additional components that you need for systems

management functions. To get all the systems management functions, select Configuration and
Service, Users and Groups, Commands, Packages and Products, and Monitors.

When you use the Selective Setup wizard, the components you select will be installed. Any
components you deselect during the selective setup will be uninstalled. Be careful not to accidentally
uninstall anything while you use the Selective Setup wizard.

When iSeries Navigator has been installed, just double-click the desktop icon to start iSeries Navigator.
Now you’re ready to [“Set up your central system.”]

Set up your central system

iSeries™ Navigator allows you to manage multiple servers from a single system in a network
environment. Some aspects of your TCP/IP environment may require changes to your Management
Central server configuration. For example, if you are using a firewall or if you want to use SSL
encryption for Management Central server communications, you may need to change some of your
Management Central server settings. ¥ For more information about using firewalls, see
[Management Central Connections for Firewall Environments| For more information about using SSL

encryption, see [SSL scenarios| <%

To manage multiple servers from a single system, you need to have a central system. The servers in your
network are called endpoint systems. You select one of these endpoint systems as your central system.
Once you[“Add endpoint systems to your Management Central network” on page 5|to your network and
select your central system, you only need to do your system administration tasks once. Your central
system will initiate your tasks and store the necessary systems management data.

Setting up your central system for the first time

To start using iSeries Navigator, double-click the desktop icon and select an iSeries server to connect to.
The first server you connect to is assigned as your central system. Management Central appears
automatically at the top of the list in the left pane of your iSeries Navigator window. The Management
Central server is automatically started on the central system. All you need to do is expand Management
Central to access the iSeries Navigator systems management functions.

If your central system is running OS/400® V5R2 or later % (or even V5R1 with PTR SI06917), ¢ you
can simply right-click Management Central and select Verify Connection to verify that the central
system connection is configured properly. To see detailed information about any Failed message, you can

select the message and click Details (or just double-click the message).

Changing your central system
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You can select a different system as your central system at any time. The central system must be a system
that you are directly connected to. For the latest iSeries Navigator functions, your central system should
be running OS/400 Version 5, Release 3 (V5R3).

If your PC is running V5R2 or V5R3 iSeries Navigator, and you want to select a central system that is
running OS/400 V5R1, you must have the following fixes (also known as PTFs) installed on the V5R1
system: SI01375, S101376, 5101377, SI01378, and SI01838. Without these fixes, you will not be able to
connect to the V5R1 system as a central system.

To change your central system, do this:
1. Right-click Management Central and select Change Central System.
2. Use the Change Central System dialog to choose a system from your list of connected systems.

3. If the system you want to use as your central system is not currently connected to your iSeries
Navigator network, right-click My Connections and select Connection to Servers —> Add
connection. When the new system is connected, you may change your central system to the new
system.

After you have[“Add endpoint systems to your Management Central network”| and [‘Create system|
loroups in your Management Central network” on page 6] those endpoint systems and system groups will
appear under Management Central as well. For more information about these and other Management
Central tasks and topics, refer to the detailed task help that is available from the iSeries Navigator
window. Just click Help from the menu bar and select Help Topics. Select What can I do with .. .? to
find out what you can do and where you need to be in the iSeries Navigator window to make it happen.
Once you have set up your central system, you are ready to do the other tasks necessary for
fwith Management Central” on page 3|

Add endpoint systems to your Management Central network

An endpoint system is any system or logical partition in your | ICP/ II5| network that you choose to
manage through your [“Set up your central system” on page 4.

#» Adding endpoint systems is basically different from adding connections. When you add a connection
to a system from iSeries™ Navigator (by clicking File -> Connection to Servers -> Add connection), the
system is added to the list under your current active environment (usually named My Connections). On
the other hand, when you add a new endpoint system, the system name is added to the list of Endpoint
Systems under Management Central. When you perform an action on a system under My Connections, a
direct connection from the client (your PC) to the system is required, and actions are performed on one
system at a time. In contrast, Management Central allows systems management tasks to be performed on
multiple systems (in the Endpoint Systems list) and only one client connection (to the central system) is
required. The central system handles the connections to the endpoint systems. ¥

If you are adding endpoint systems that are running OS/400® V5R1, you must have the following fixes
(also known as PTFs) installed on the V5R1 system: S101375, SI101376, SI01377, S101378, and SI01838.
Without these fixes, you will not be able to use all the systems management functions on the endpoint
system.

To manually add one or more endpoint systems, do the following:
1. Right-click Endpoint Systems and select New Endpoint System.
2. Enter the name of the system and click OK.

That is all there is to it. The endpoint systems that you added appear automatically under Endpoint

Systems in your iSeries™ Navigator window. Once you have added an endpoint system, you can view
its properties, and you can change the description 3 or the IP address €% as needed.
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Next, you can [“Create system groups in your Management Central network”] to help you manage
different sets of endpoint systems. The new system groups will appear inder Management Central in
iSeries Navigator. For more information about these and other systems management tasks and topics,
refer to the detailed task help that is available from the iSeries Navigator window. Just click Help from
the menu bar and select Help Topics. Select What can I do with . . .? to find out what you can do and
where you need to be in the iSeries Navigator window to make it happen.

Create system groups in your Management Central network

A system group is a collection of endpoint systems that you define. Remember, an endpoint system is
any system or logical partition in your TCP/IP network that you choose to manage through your central
system.

Endpoint systems can belong to several system groups at the same time. Once you have created a system
group, you can manage the entire group from your central system as if it were a single system.

To create a system group, follow these quick steps:
1. Open Management Central from your iSeries"™ Navigator window.
2. Right-click System Groups and select New System Group.

3. On the New System Group dialog, specify a unique name for the new system group. You can also
enter a brief description that will help you later identify this group in a list of system groups.

4. From the Available systems list, select the endpoint systems that you want to include in this new
group. Click the Add button to add the systems to the Selected systems list.

5. If you want to give other users the ability to view or change this system group, Click the
Sharing tab and specify Read-only or Full sharing. If you specify None, other users will not be able
to view or change this system group #r unless they have special authority, which is administered
under Host Applications in Application Administration. Users with this special authority, called
Management Central Administration Access, can view all tasks, definitions, job monitors, message
monitors, and system groups under Management Central in the iSeries Navigator window.4¥,

6. Click OK to create the new system group.

The system group you create will include all the endpoint systems you entered. You may decide later that
you want to edit that list of endpoint systems. You can always add more endpoint systems or remove
endpoint systems from your system group. You can even delete system groups from Management
Central. When you delete a system group or remove endpoint systems from a system group, only the
system group is changed. The endpoint systems that were in the system group are still listed under
Endpoint Systems in the iSeries Navigator window. ¥ Of course, if you delete an endpoint system from
the Endpoint Systems list, that endpoint system is removed from all system groups. 4

For more information about these and other systems management tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Just click Help from the menu bar and
select Help Topics. Select What can I do with . . .? to find out what you can do and where you need to
be in the iSeries Navigator window to make it happen.

Working with Management Central

Click Management Central in the iSeries™ Navigator window to streamline your system administration
tasks. To make the most of Management Central, first set up your systems for Management Central. Then
you can efficiently complete the tasks required to manage your systems. To learn about setting up your
systems for Management Central, see the [“Get started with Management Central” on page 3| topic. To
learn how iSeries Navigator can help you manage your system administration tasks easily and efficiently,
keep reading.
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% You can use EIM and Kerberos authentication together to eliminate the need to provide multiple user
names and passwords for distributed applications. For more information on using EIM and Kerberos
authentication together in this way (also known as “single signon”), see . &

You can use iSeries Navigator’s powerful suite of systems management functions to handle all your

system administration tasks.

Run commands

Manage users and groups

Collect inventory

Monitor system performance and
resources

Manage fixes

Collect performance data

You can use iSeries Navigator to on multiple systems. For

commands that you want to run on a regular basis, simply create a command
definition and schedule it to run on any endpoint systems in your network. For
assistance anytime you are entering or selecting an OS/ 400® command, just
click the Prompt button to see a complete list of the parameters and values for
the command.

Keep track of the users, groups, and their privileges on multiple systems using
iSeries Navigator’sluser administration| function. You can also create, send, edit,
and delete users across multiple systems.

You can fcollect and manage various inventoried on a regular basis and store the
data on a designated central system. For example, you can collect the inventory
for users and groups, fixes, system values, hardware resources, software
resources, service attributes, contact information, or network attributes. You may
have other applications installed that allow you to collect lists of other types of
resources.

You can search the hardware, software, fixes, and users and groups inventories
based on criteria that you specify. You can export the results of the search or an
entire inventory to a PC file to use with PC applications and to perform other
queries.

In iSeries Navigator, you can use to track what your systems are doing.
You can monitor jobs, messages, files, B2B activity, and system performance.
Using the you can also track events created by these monitors. You
can view all your monitors, as well as all your systems management tasks,
remotely with [iSeries Navigator for Wirelesg

Keep your (or program temporary fixes, PTFs) current across multiple
systems. Use iSeries Navigator to efficiently manage fixes on one or more
endpoint systems. You can send, install, and compare and update fixes. Use fix
groups to manage multiple fixes as a single item. A fix group simply defines a
list of fixes and related fix groups.

Use [Collection Services|to collect system performance data that you can use for
later analysis (for example, using Performance Tools for iSeries). See a graphical
view of the metrics that you collected for an extended period of time with the
[Graph History window] You can use the Graph History function as long as you
collect data with Collection Services; you do not need to have a system monitor
running.
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Maintain consistency across iSeries Navigator lets you view, compare, and update system values—everything
multiple systems required to efficiently [manage system values|across multiple systems in your
network.

4% Choose a model system that has the most accurate date and time values, and
then [synchronize the date and time| values on selected endpoint systems or
system groups with the values on the model system. You can choose to
synchronize the time without changing the time zone, or synchronize both the
time and the time zone with those on the model system. ¥

%% Save time by [synchronizing key functions| from a model system across
multiple systems in your network instead of individually configuring each
function on each target system. <%

Manage software products You can use iSeries Navigator to lpackage and send software products|to the
systems in your network. You simply create a product definition to identify your
application as a product to the iSeries server. The product definition contains all
the information that you need to send and install a product across multiple

systems, just like you would install an IBM® licensed program. You can also
for these user-defined software products.

You can also send any software product from the software inventory.

Package and send objects You can [package and send objects|to systems in your network using iSeries
Navigator. You can create snapshots of your data to preserve more than one
version of the data.

Schedule unattended tasks or jobs Use iSeries Navigator’s integrated to automate recurring tasks. You can
choose to run a task immediately, or you can use the scheduler to select a later
time. You can schedule a task to run just once, or you can schedule it to run
daily, weekly, or monthly at a convenient time. You can also use the
a separate licensed program that provides more calendar features

and offers greater control over scheduled events.

Finally, iSeries Navigator makes system administration even easier by allowing you to
fresources with other users| Do not forget to use the online help available to you in iSeries Navigator. The
online help offers tips and techniques for making the most of the iSeries Navigator systems management
functions, including “What’s This?” help, how-to information, and extended examples.

Related information for Management Central

Listed below are the IBM® Redbooks™, Web sites, and Information Center topics that relate to the
Management Central topic. In addition to these resources, you can find more information about
Management Central tasks and topics in the detailed task help in iSeries™ Navigator. Just click Help
from the menu bar and select Help Topics. Select What can I do with . . .? to find out what you can do
and where you need to be in the iSeries Navigator window to make it happen.

Redbooks

You can view the following Redbooks published by the IBM International Technical Support Organization
(ITSO) to find out more information about Management Central:

+ % [Managing OS/400 with Operations Navigator V5R1 Volume 1: Overview and More] %

+ [Managing OS/400 with Operations Navigator V5R1 Volume 2: Security| %‘
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[Managing OS/400 with Operations Navigator V5R1 Volume 3: Configuration and Service@

[Managing OS/400 with Operations Navigator V5R1 Volume 4: Packages and Products]@

[Managing OS/400 with Operations Navigator V5R1 Volume 5: Performance Management@

Managing OS/400 with Operations Navigator V5R1 Volume 6: Networking[& L4

Web sites

There are a variety of Web sites you can use to find more information about Management Central. These
include:

topic in the Information Center.

fiSeries Navigator]

5

iSeries Navigator provides a wide variety of tools to simplify iSeries management. Go to the iSeries
Navigator home page to find information about iSeries Navigator, including functional release
overviews, news about technical conferences, and other hot topics. You'll find links to a variety of
information including release updates, functional overviews, FAQs, and more. For information about
installing and getting started with iSeries Navigator, be sure to see the [iSeries Navigator]topic in the
Information Center.

iSeries Navigator for Wireless|

Access systems management functions on the go! The iSeries Navigator for Wireless Web page gives

you more information about this exciting solution for pervasive computing. See the Web page for
information on the V4R5 and V5R1 releases. For V5R2 and later information, see the [iSeries Navigator]|

Other information

# You will find links from various places in the Management Central topic to other Information Center
topics that relate to Management Central. The following Information Center topics are especially
significant for V5R3:

* [Single signo

If you have been looking for a way to simplify the task of managing user profiles on the iSeries server,
single signon may be the answer for you. This information presents a single signon solution for the
iSeries server, which uses the technology of Enterprise Identity Mapping (EIM), paired with the iSeries
network authentication service. The single signon solution simplifies the task of managing user
profiles, while reducing the number of signons that a user must perform to access multiple applications
and servers.

This topic includes a scenario that demonstrates how to configure an entire system group to participate
in a single signon environment. After administrators complete the scenario for propagating a single
signon configuration across multiple systems, they can do the necessary configuration so that the entire
system group can participate in the single signon environment.

+ [Configuring Management Central Connections for Firewall Environments|

This report details Management Central connections and the configurations required to enable
Management Central to operate within a variety of firewall environments. As a distributed
management application, Management Central requires numerous incoming and outgoing TCP/IP
socket connections. In contrast, the basic premise of a firewall is to restrict/modify incoming and
outgoing connections.£¥,
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation

Licensing

2-31 Roppongi 3-chome, Minato-ku

Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the

exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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IBM Corporation

Software Interoperability Coordinator, Department 49XA
3605 Highway 52 N

Rochester, MN 55901

U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this information and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement,
IBM License Agreement for Machine Code, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

Trademarks

The following terms are trademarks of International Business Machines Corporation in the United States,
other countries, or both:

e(logo)server

IBM

iSeries

Operating System /400

0S/400

400

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of others.

Terms and conditions for downloading and printing publications

Permissions for the use of the information you have selected for download are granted subject to the
following terms and conditions and your indication of acceptance thereof.

Personal Use: You may reproduce this information for your personal, noncommercial use provided that

all proprietary notices are preserved. You may not distribute, display or make derivative works of this
information, or any portion thereof, without the express consent of IBM.
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Commercial Use: You may reproduce, distribute and display this information solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of this
information, or reproduce, distribute or display this information or any portion thereof outside your
enterprise, without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the information or any data, software or other intellectual property contained
therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the information is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations. IBM MAKES NO
GUARANTEE ABOUT THE CONTENT OF THIS INFORMATION. THE INFORMATION IS PROVIDED
"AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT,
AND FITNESS FOR A PARTICULAR PURPOSE.

All material copyrighted by IBM Corporation.

By downloading or printing information from this site, you have indicated your agreement with these
terms and conditions.
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